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Resumen

En este trabajo se describirá brevemente como mani-
pular imágenes con los programasxv, ImageMagick
y gimpdel sistema operativo GNU/Linux. El objeto
del trabajo es enseñar las herramientas básicas para
la edicíon y manipulacíon de iḿagenes que podrı́an
ser incluidas en nuestras presentaciones y particular-
mente en documentos LATEX. Por último se realiza
una animacíon usando las herramientas básicas de
GNU/Linux y el programagimp.

1 Introducci ón

La edicíon de iḿagenes y su inclusión en documen-
tos de texto es una tarea muy común hoy en d́ıa, en
un mundo en el que las iḿagenes predominan co-
mo el medio principal para la transmisión de ideas.
Un ejemplo inmediato lo vemos en el diseño de las
páginas que se ponen disponibles en la WEB. Es
por ello que resulta importante conocer con que pro-
gramas contamos en GNU/Linux para la edición de
imágenes y como podemos incluirlas en los docu-
mentos que realizamos.

En este artı́culos nos enfocaremos a tres tareas
básicas:

1. Cómo crear o capturar iḿagenes nuevas.

2. Cómo editar iḿagenes para agregarles etiquetas
y texto, y

3. Cómo realizar animaciones.

Los tres programas que veremos sonxv, Image-
Magick y gimp. De entrada para usar estos progra-
mas es muy importante contar con un ratón de tres
teclas, ya que todos estos programas lo usan. Si sólo
se cuenta con un ratón de dos teclas hay que habili-
tar la emulacíon de tres botones cuando se configura
el sistema X (el bot́on central se emula presionando
los dos botones al mismo tiempo). Como “sistema
X” se conoce la suite de programas que nos permite
trabajar en un ambiente gráfico en GNU/Linux.

2 El programa xv

Xv permite visualizar iḿagenes en varios formatos,
tales como GIF, JPEG, TIFF, PBM, PGM, PPM, X11
bitmap, etc. (vea el manual que queda instalado en
el archivo /usr/doc/xv-3.10a/xvdocs.ps, o las páginas
man).

Este programa se distribuye en dos archivos
RPMS en la versión 7.x de RedHat Linux: xv-3.10a-
23.i386.rpm y xv-docs-3.10a-23.i386.rpm, y forman
parte de la distribución de PowerTools. Antes de la
llegada de las distribuciones por medio de rpm (Red
Hat Packet Manager), habı́a que bajar el ćodigo fuen-
te de Internet, adecuarlo a nuestra máquina Unix,
compilarlo e instalarlo. Ahora esto es trivial con el
comandorpm -i %.rpm , para instalar un paquete
%.rpm .

Xv es un famoso programa escrito por John Brad-
ley y el sitio primario para obtener el código fuen-
te es ftp.cis.upenn.edu en el directorio pub/xv. Un
art́ıculo que habla sobre xv está en la referencia [1].
xv tambíen puede usarse para capturar imágenes en
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GNU/Linux por medio de un scanner [2]. Xv tiene el
inconveniente de que no es libre (freeware), essha-
reware, esto es, libre para uso personal. El costo de
registro es de 25 USD y están disponibles licencias
institucionales.

Para ejecutarlo simplemente se puede teclearxv
en la ĺınea de comandos, y aparecerá la “imagen lo-
go” de xv. Para visualizar una imagen se ejecuta
xv nombre_imagen . La ventana principal de co-
mandos de xv aparece al hacer clic con el botón iz-
quierdo del rat́on sobre la imagen desplegada por xv
y puede verse en la Fig. 1

Figura 1: La ventana de control de xv que se despliega al
hacer clic con el botón izquierdo sobre la imagen desple-

gada.

Una caracterı́stica de xv muýutil es la capacidad
de capturar una ventana o trozos de la pantalla en una
imagen, para ello debemos utilizar el botónGrab que
puede verse en la parte inferior derecha de la Fig. 1.
Es posible usar xv totalmente a través del teclado ha-
ciendo uso de las teclas rápidas (cada tecla tiene asig-
nada una función, la ventana de control se abre pre-
cionando la tecla ‘?’). Al hacer clic sobre el botón de
Grab sale otra ventana en la que se puede introducir
un tiempo de retardo después del cual, si se oprime
la tecla izquierda del ratón se graba una ventana, si
se mantiene oprimida la tecla central se graba unárea
rectangular que puede abarcar toda la pantalla, y si se
oprime la tecla derecha se cancela la acción de gra-
bar.

Otra utilidad importante es la ventana de edición
de colores,Windows→ Color Editor (u oprimiendo

la letra ‘e’ con el cursor sobre la imagen) abre esta
ventana. Aqúı se pueden aplicar una normalización
y/o igualacíon del histograma, que son dos técnicas
de procesamiento de imagen muyútiles cuando se
tiene una imagen con un contraste muy pobre; ası́
como tambíen se puede modificar el color asociado a
los pixels de la imagen.

Porúltimo, es muy f́acil cortar un trozo de imagen
seleccionando una región rectangular, manteniendo
oprimido el bot́on derecho del ratón sobre la ima-
gen, y oprimiendo después el bot́on Crop (o la tecla
‘c’). Las medidas exactas de la región de corte pue-
den verse si se despliega la ventana de información
de la imagenWindows → Image Info (o la tecla
‘i’).

3 El paquete ImageMagick

Para instalar ImageMagick son necesarios los
siguientes archivos RPM ImageMagick-5.2.7-2-
.i386.rpm, ImageMagick-devel-5.2.7-2.i386.rpm,
ImageMagick-c++-5.2.7-2.i386.rpm, e Image-
Magick-c++-devel-5.2.7-2.i386.rpm para la versión
de RedHat 7.1. Estos archivos forman parte de la
distribucíon est́andar de RedHat.

ImageMagick es un paquete de programas en
X11 para la visualización y manipulacíon de
imágenes. Fue desarrollado por DuPont y el
sitio primario para obtener el código fuente es
ftp://ftp.wizards.dupont.com/pub/Image-Magick/

ImageMagick est́a compuesto por nueve progra-
mas: display, import, animate, montage, convert,
mogrify, identify, combiney xtp. Los que usaremos
sondisplay, para desplegar y editar interactivamente
una imagen;convert, para conversión entre distintos
formatos; ymontagepara combinar varias iḿagenes.
El programaimport nos puede servir para capturar
una ventana o toda la pantalla. La documentación de
ImageMagick est́a en formato HTML en el directo-
rio /usr/share/doc/ImageMagick-5.2.2, donde puede
verse toda la documentación de cada programa o en
las ṕaginas man.

Vamos ahora a realizar algunas operaciones con
una imagen. Supongamos que queremos agregarle
texto. Para ello, a una imagen ya creada (puede ha-
cerse grabando una parte de la pantalla con xv), se
realiza:
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1. Abrir la imagen dando en la lı́nea de comandos
display nombre_imagen .

2. Haciendo clic con el botón izquierdo del rat́on,
se despliega la ventana del menú de ImageMa-
gick. ConImage Edit → Annotate se desplie-
ga el meńu para agregar anotaciones. Se selec-
ciona el tipo de font, su color, el color de fondo
(Box Color) y si es un texto rotado; finalmen-
te se hace clic con el botón izquierdo del rat́on
sobre la imagen en la posición que queremos in-
troducir el texto.

3. Se repite el paso 2 para cada etiqueta de texto
que queramos introducir en la imagen.

Si las etiquetas de texto las queremos poner sobre
un borde fuera de la imagen, hay que hacerImage
Edit → Add Border. . . , luego seleccionamos el co-
lor del borde, y el tamãno de la geometrı́a del borde
(por defecto el tamãno es de6× 6 pixels). Podemos
quitar un borde que no queramos con la operación
Transform → Chop.

Para agregar alguna figura geométrica, una ĺınea,
circulo, circunferencia, etc., se realizaImage Edit
→ Draw. . . y se abre el meńu de dibujo. Su uso es
intuitivo, por lo que no se describirá aqúı.

Las “operaciones rápidas” (short cuts) se desplie-
gan si se hace clic sobre la imagen con el botón de-
recho del rat́on. Y aśı podemos desplegar la infor-
macíon del imagen, deshacer una operación (undo)
o salvarlo con otro formato (ó hacerFile → Save
sobre el meńu principal).

Un uso avanzado de ImageMagick, muy bien des-
crito en la documentación, es el uso de sus funciones
de manipulacíon de imagen a través de un lenguaje
de programación como PERL [3], C,́o C++.

4 El programa gimp

Gimp es el Programa Manipulador de Imágenes de
GNU (GNU Image Manipulation Program). Gimp ha
sido disẽnado pensando en contar con un programa
libre profesional para manipular iḿagenes. Para sa-
ber ḿas sobre el proyecto GNU visite www.gnu.org

En RedHat 7.1, la distribución completa de
gimp consta de cuatro archivos RPM: gimp-1.2.-
1-5.i386.rpm, gimp-data-extras-1.2.0-1.noarch.rpm

gimp-devel-1.2.1-5.i386.rpm y gimp-perl-1.2.1-5.-
i386.rpm; aunque los dośultimos son necesarios sólo
para programadores.

El sitio primario de informacíon para gimp es
www.gimp.org y existe un excelente manual en lı́nea
en manual.gimp.org . El uso degimp es complejo
y se convida referirse al manual para apoyarse en su
uso.

Vamos a ver un ejemplo de como crear un GIF ani-
mado usando como ejemplo el juego LIFE de vida ar-
tificial. El juego LIFE fue creado por John Conway
en 1970 [4] y consiste de una serie de células, ca-
da una de las cuales tiene ocho células vecinas. Una
célula se considera ocupada (por un organismo) o de-
socupada. Las reglas para derivar una generación son
las siguientes: Si una célula ocupada tiene 0, 1, 4,
5, 6, 7 ú 8 ćelulas vecinas ocupadas, el organismo
muere(0, 1, muere por aislamiento; 4-8 por sobrepo-
blación); si una ćelula ocupada tiene dos o tres veci-
nas ocupadas, el organismosobrevivea la siguiente
generacíon; si una ćelula desocupada tiene tres veci-
nas ocupadas, la célulanace, esto es, se convierte en
ocupada. Una b́usqueda en Internet en cualquier bus-
cador, p.e. www.google.com con la clave “game life
scientific american” nos dará cientos de referencias
sobre LIFE.

En el aṕendice se presenta el código en PERL pa-
ra el juego LIFE. En el ćodigo, cada ćelula corres-
ponde a un pixel sobre una imagen y las células ve-
cinas a los ocho pixels vecinos aél[5, p. 40]. Los
datos necesarios para su ejecución son el tamãno de
las imágenes, el ńumero de generaciones y la pobla-
ción (imagen) inicial, que se pueden editar al ini-
cio del ćodigo. Se incluye una función para guar-
dar una imagen (que representa a una generación, ó
un marco [frame] de nuestra animación) en formato
PBM legible por cualquiera de los programas descri-
tos aqúı. El listado puede obtenerse en la dirección
http://delta.cs.cinvestav.mx/˜ fraga/Programas/life.pl

Para ejecutar el programa hay que volver el archi-
vo ejecutable y ejecutarlo propiamente:

chmod 700 life.pl
./life

Obtendremos de salida diez imágenes cuyos nombres
tienen el formatot_????.pbm , donde???? va de
0001 a 0010 (por tener la variable$generations
definida igual a 10).
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Las imágenes de salida son muy pequeñas y para
escalarlas podemos usar el programa en PERL de la
Fig. 2.

#!/usr/bin/perl

@files = ‘ls -1 *.pbm‘;
# Tenemos los nombres en el arreglo @files
$n = @files; # El n úmero de im ágenes

for ( $i=0; $i<$n; $i++ ){
$name = sprintf ( "a_%04d.tif", $i );
$input = $files[$i];
chop ( $input );
print "E: -scale 64 $input $name\n";
‘convert -scale 64 $input gray:tmp‘;
‘convert -size 64x64 gray:tmp $name‘;

}

Figura 2: El programa en PERL usado para escalar las
imágenes para nuestra animación

Para el programa de la Fig. 2, el comando
chop ( $input ) quita elúltimo caracter a ca-
da nombre de la imagen de entrada. Se quita este
caracter porque representa al retorno de carro ‘\n ’.
Se observa también sobre la Fig. 2 que se utiliza el
programaconvertde ImageMagick para escalar las
imágenes de entrada al nuevo tamaño de64× 64 pi-
xels.

Gimp puede realizar un GIF animado solamente
con imágenes en tonos de gris o en color verdadero
RGB (en estas iḿagenes cada pixel está representado
por su tripleta de componentes de color rojo, verde y
azul), es por ello que se utiliza dos veces el programa
converten la Fig. 2, una para crear una imagen tem-
poral ya escalada en tonos de gris y luego cambiamos
el formato de la imagen temporal a una imagen TIF
cuyo nombre tendrá el formatoa_????.tif donde
‘????’ tendŕa la misma numeración que las iḿagenes
t_????.pbm de salida del programa life.pl. Este
formato define un marco para gimp.

Para realizar ahora la animación con gimp es muy
sencillo. Ejecutamos gimp y abrimos la primera ima-
gena_0001.tif . Y sobre esta imagen agregamos
todo los deḿas marcos: clicamos con el botón de-
recho del rat́on sobre la imagen abierta y usamos la
opción Video → Frames to Image; aqúı se abre
una nueva ventana donde podemos editar el tiempo
de exposicíon de los marcos (por defecto es 41 mili-
segundos), para nuestro ejemplo un valor razonable

es del 800 mseg. La animación creada es mostra-
da por gimp en una nueva ventana; clicando son el
botón derecho del ratón sobre esta ventana podemos
ver la animacíon con la opcíonFilters → Animation
→ Animation Playback. Finalmente, para salvar la
animacíon creada usamos la opción File → Save,
se abre una nueva ventana donde debemos poner el
nombre del archivo de salida y escogemos el formato
de salida como GIF. La animación final puede visua-
lizarse tambíen con cualquier visor de WEB (netsca-
pe, OutLook, etc.).

En el caso de que se hayan creado cada mar-
co como iḿagenes en color, deben salvarse como
imágenes en color verdadero o RGB. Una vez que
se han agregado todos los marcos, hay que cambiar-
los a iḿagenes indexadas usandoImage → Mode
→ Indexed. De esta manera es posible salvar la ani-
macíon en color como un gif animado.

Es posible también visualizar todos los marcos
conxvo conanimate(que es parte de ImageMagick).
Con xv se usarı́a el comando:

xv -wait 1 -wloop a_00??.tif

donde la opcíon -wait 1 es para mostrar cada
imagen por un intervalo de 1 segundo, y la opción
-wloop es para que entre en un ciclo donde mues-
tre continuamente todas la imágenes al terminar con
la última.

Para visualizar todos las iḿagenes con el progra-
maanimatede ImageMagick se harı́a simplemente:

animate a_00??.tif

y clicando con el bot́on izquierdo sobre la imagen
abierta se puede controlar la velocidad de exposición
de cada imagen con la opción Speed → Faster y
Speed → Slower.

Nueve generaciones del juego LIFE, de salida del
programa life.pl en el aṕendice, se muestran en la
Fig. 3. Esta imagen fue generada con el programa
montagede ImageMagick con las opciones:

montage -tile 3x3 -geometry 16x16 *.pbm a.tif

Se invita a ver las ṕaginas man demontagepara la
explicacíon de cada una de estas opciones.

5 Conclusiones

Se han presentado tres programas para la edición
y creacíon de iḿagenes en el sistema operativo
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Figura 3: Nueve generaciones del juego LIFE tal como
se obtienen al ejecutar el programa life.pl mostrado en el
Apéndice. Se forma un patrón “estable”, que puede com-
probarse al aumentar el número de generaciones sobre el

programa life.pl

GNU/Linux: xv, ImageMagick y gimp. Xv e Image-
Magick vienen con una muy buena documentación
desde la instalación de ellos. Gimp tiene un exce-
lente manual en lı́nea en la dirección http://manual.-
gimp.org.

Se ha presentado la creación de animaciones con
gimp, usando como ejemplo el juego LIFE, progra-
mado en el lenguaje de muy alto nivel PERL. Gimp
es un paquete para uso profesional de edición de
imágenes en el sistema GNU/Linux. Debido a que
en cada nueva versión de gimp, las opciones y po-
sibilidades del programa cambian continuamente, se
recomienda leer la documentación para profundizar
en sus opciones y sus capacidades.

Las opciones que ofrecen ImageMagick y gimp
para edicíon de iḿagenes pueden usarse también des-
de programas en PERL, Ćo C++. Esto representa
programacíon avanzada y se recomienda dirigirse a
la documentación si se est́a interesado en este modo
de usarlos.

En general se recomienda dirigirse a la documen-
tación de estos programas para profundizar en su uso,
ya que aqúı solo ha realizado una muy breve intro-
duccíon al uso de ellos, con el fin de motivar a usar-
los en este mundo donde la transmisión de ideas se
realiza a trav́es de iḿagenes, y con la ventaja de que
no debemos de pagar por ellos.
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Apéndice

#!/usr/bin/perl

# Programa en PERL para generar en imagen PBM
# una generaci ón del juego LIFE

# Las dimensiones de la imagen de salida
$rows = 16;
$cols = 16;
$generations=10; # El n úmero de generaciones,

# una imagen por generaci ón

# La imagen inicial
for ( $i=0; $i<$rows; $i++ ) {

for ( $j=0; $j<$cols; $j++ ) {
$img[ $cols * $i + $j ] = 0;

}
}
$n = $rows/2;
for ( $i=$n-2; $i<=$n; $i++ ) {

for ( $j=$n-2; $j<=$n; $j++ ) {
$img[ $cols * $i + $j ] = 1;

}
}

# La realizaci ón del juego LIFE:
for ( $g=1; $g<=$generations; $g++ ) {

$name = sprintf( "t_%04d.pbm", $g );
print "Se guarda imagen $name\n";
save_pbm_img ( \@img, $rows, $cols, $name );
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for ( $i=0; $i<$rows; $i++ ) {
# Consideramos a la imagen un toro
$y1 = ($i-1) % $rows;
$y2 = ($i+1) % $rows;

for ( $j=0; $j<$cols; $j++ ) {
$x1 = ($j-1) % $cols;
$x2 = ($j+1) % $cols;

$suma = 0;
$suma += $img[ $cols * $y1 + $x1 ];
$suma += $img[ $cols * $y1 + $j ];
$suma += $img[ $cols * $y1 + $x2 ];
$suma += $img[ $cols * $i + $x1 ];
$suma += $img[ $cols * $i + $x2 ];
$suma += $img[ $cols * $y2 + $x1 ];
$suma += $img[ $cols * $y2 + $j ];
$suma += $img[ $cols * $y2 + $x2 ];

if ( $img[ $cols * $i + $j ] > 0 ) {
if( $suma <= 1 || $suma >= 4 ) {

# Muere el bicho
$imgout[ $cols * $i + $j ] = 0;

}
else { # Vive el bicho

$imgout[ $cols * $i + $j ] = 1;
}

}
elsif( $suma == 3 ) { # Nace uno!

$imgout[ $cols * $i + $j ] = 1;
}

}
}
# Copiamos la imagen @imgout a @img
for ( $i=0; $i<$rows*$cols; $i++ ) {

$img[$i] = $imgout[$i];
}

}

# Subrutina para salvar una imagen en formato PBM
# crudo (Portable Bitmap Map, ver la p ágina man de
# "pgm" sobre el paquete NETPBM)
# Entrada: ( @img, $rows, $cols, $filename )
sub save_pbm_img (\@$$$) {

local (*myimg) = shift(@_);
my $mycols = shift(@_);
my $myrows = shift(@_);
my $filename = shift(@_);

open ( MYFILE, ">$filename" ) or return 1;
select MYFILE; $| = 1;

print MYFILE "P4\n";
print MYFILE "# file: $filename\n";
print MYFILE "$mycols $myrows\n";

my $data; my $n = int( ($mycols + 7)/8 )*8;
for ( my $i=0; $i<$myrows; $i++ ){

$data = "";

for ( my $j=0; $j<$mycols; $j++ ){
if ( $myimg[ $mycols * $i + $j] ) {

$data = $data.’1’;
}
else { $data = $data.’0’; }

}
my $bytes = pack( "B$n", $data );
syswrite ( MYFILE, $bytes );

}
close MYFILE;
select STDOUT;
return 0;

}


